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1. Welcome

Dear reader, thank you for choosing IGMAS+ and welcome to the IGMAS+ Online Documentation!

This website aims to enhance your understanding of the fundamental capabilities of the IGMAS+ software and offer basic

support. It provides a detailed explanation of how to fully utilize the powerful graphical interface of IGMAS+.

This documentation is the result of diligent and meticulous work carried out by the members of the IGMAS+ Team over the

years. Their motivation stems from the high demand within the IGMAS+ user community for an in-depth description of the

software.

We encourage you to take your time to become familiar with IGMAS+ and bear in mind that this documentation has been

written by non-native English speakers.

We believe that IGMAS+ will significantly contribute to your scientific endeavors, aiding in the integrated, interdisciplinary

interpretation of complex geological structures at the macro-, meso-, and micro-scale.

This online documentation is under ongoing development: some parts can be missing and some materials can look incorrectly.

1.1 Download as PDF

This website can be downloaded as a standalone PDF file.

Download  

The former IGMAS+ User Manual is available here.

1.2 Quick links

 Tutorial

Gravity and magnetic modelling basics blended with IGMAS+ practical insights

 Workflows

Typical IGMAS+ workflows explained in a simple and efficient way

Warning

1. Welcome
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1.3 Discover more

  Get the installer

Download IGMAS+  

 Browse Versions

  Set up quickly

This quick tutorial will show you how to install and run IGMAS+ on different platforms

 Getting Started

  No cost license

IGMAS+ is provided at no cost according to the IGMAS+ license agreement

 Get License

  Read more

Discover IGMAS+: the team, history, and the timeline of IGMAS+ across years

 About IGMAS+

2024-02-02
 

1.3 Discover more
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2. Workflows

Design isn’t finished until somebody is using it.

― Brenda Laurel

2.1 Preface

In the "Workflows" chapter we break down the steps to make your IGMAS+ project smoother.

You will learn here how to handle project parameters, explore different displays and visuals for a better view of your model, and

discover seamless methods of importing model geometry, as well as easy ways to save and load your work.

Let's simplify the process of getting things done in IGMAS+!

2.2 Setting up interface appearance

Before getting started, two more decisions related to the program interface can be made that is independent of the modelling

process: 

the language of the interface

the external appearance (interface theme).

2.2.1 Language

Click “Edit” in the TITLE BAR > select “Options” > and then “Language”:

Select interface language: English or German

2.2.2 Theme

Click “Edit” in the TITLE BAR > select “Options” > and then “Look & Feel”:

Quote

• 

• 

2. Workflows
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Select interface theme: selected one is "light"; in addition, there is a

large number of colour shades for both “light” and “dark”.

2.3 Importing horizons

This Workflow is used if existing digital data define continuous horizons in the entire modelling area.

Several horizons are stacked, the physical parameters between the interfaces are assumed to be constant.

Users must use one file for each horizon.

File formats

The following formats are possible: *.xyz , *.csv  or Geosoft binary grid format *.grd , see Manual Section 6.3 on page 132. Preferred

is the file format *.csv .

Point types

The points defining the horizons may be gridded or irregularly distributed. Points with identical location but different z-values will be

averaged (there will be a notice).

Before we get started, here are a few tips to make sure the input works:

2.3 Importing horizons
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The points are interpreted to represent point locations x, y, z. They are not to be confused with grid cells, which are not used

here, even in case of regularly gridded horizons.

Make sure that the files are read in such a way that they always start with the top horizon. The order (from top to bottom) is very

important, because it directly controls the triangulation. We will come back to this in a moment.

Have you prepared the "correct gravity field"?

That means, do you want to calculate with a FREE AIR or with a BOUGUER anomaly?

In both cases a topography file must also be read in. Here you have to make sure that the model stations are NOT located inside the

model masses - otherwise the mathematics behind everything will not work and the gravity will be calculated incorrectly.

Make sure that the units are correct: give densities in , gravity in  or , depths and lengths in  or .

And finally: did you prepare your model data files for a plane gravity calculation (use UTM, Gauss-Krüger coordinates) or for a

spherical calculation (use geographic coordinates with latitude and longitude)?

If all this is considered, it goes off, assuming that IGMAS+ is installed correctly.

2.3.1 How to import model geometry?

Choose File > New Project > Irregular/Regular Horizon (XY-Plane) Import. Choose the directory and the file(s) to be

imported. Make sure to select all files for the model to be built, as later inclusion of additional horizons is not possible. This is

how it looks like:

Press Finish 

Now you see the following mask:

But beware:

• 

• 

• 

• kg/m3 mGal 10−5m/ s2 km m

• 

2.3.1 How to import model geometry?
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On the right, the input files are listed with the horizons from top to bottom. Below that the "Folder name" is displayed and below

that the file type.

Press Next 

Der “import wizard” lists all imported horizons (files) and orders them from top to bottom according to the value Zmin. Make

sure, that the list corresponds to the stratigraphic column / layering in your modelling area. We had already pointed this out

above. If necessary, change the order using the arrows on the right hand of the wizard.

2.3.1 How to import model geometry?
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From left to right, the following information is displayed:

Name This name will be used as the name of the body below the corresponding horizon. Can be changed later.

# of points Number of points to be read from file (for information only).

Area Minimum x-coordinate, minimum y-coordinate, size in x-direction, size in y-direction (for information only).

Zmin Minimum depth of the horizon (for information only, the value is used to define the layer order.

Zmax Maximum depth of the horizon (for information only).

# of x-points, # of y-points This value is used to apply averaging of horizon vertices on regularly spaced locations. Default is 0

for irregular points and original number of points for grids (no averaging). All three coordinates (X, Y and Z) will be averaged

using the block average method (see Section 6.1.4 on page 124). Alternatively, user can use x-spacing and y-spacing to set up

the grid for averaging (see below).

x-spacing, y-spacing Instead of setting number of points one can set desired spacing and corresponding number of points will

be automatically recalculated.

The last four columns can be used for filtering of highly oversampled horizons. Sometimes seismologists provide Moho depths data in

a resolution of 100 m x 100 m ;-)

Press Next 

The next wizard defines the general model parameters:

Hint:

2.3.1 How to import model geometry?
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You see:

Extend model borders. Check, if the model should be extended laterally, and specify the model extension (Range). Refer to

Section 5.10 on page 121 to read more about the model extension.

Minimum vertical distance. Minimum thickness of bodies. It is used only if the imported vertices have identical horizontal

positions throughout all horizons or if the vertices are interpolated regularly on the sections (see Project Points (Mundry)

below). In our example it is 2.2 m.

Z-Top. Depth of the upper limit of the model (plane, horizontal). Default 0, if no topography is given, otherwise maximum Zmin

of all horizons. In the example input file, there is no topography in the model.

Z-Button. Depth of the lower limit of the model (plane, horizontal). Default: minimum Zmin value of all horizons. The biggest

depth is 400 km (upper mantle); this is the bottom of the density model – set by the user.

Units. Make your choice depending on the data entered (depths, distances, grid spacing, etc.). Here we used “km”.

Project Points (Mundry). Interpolate irregularly spaced horizon vertices on the sections to be build. Default is: no.

In our model, we wanted to re-interpolate the data ("even" grid spacing). For this purpose a procedure according to Mundry is

used.

Press Next 

2.3.1 How to import model geometry?
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Almost done: In this last wizard we are able to specify the area to be modelled and the position of the vertical sections.

By default, the modelling area is the maximum area, which is covered by all horizons - indicated by a grey rectangle. Five vertical

model layers are given by default. The first and fifth/last are hidden by the frame. They will be visible in the next image. The

numbers at the border indicate the coordinates - in the example these are UTM coordinates.

Green dot___Defines the max. south-west corner of the modelling area.

Red dot_____Defines the max. north-east corner of the modelling area.

You may change the position of the circles by either clicking with the right mouse button on them (alphanumeric input); (an

example for the coordinate input of the red point you can see here):

2.3.1 How to import model geometry?
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or just dragging them. Both input options redefine the model boundaries, also change the spacing of the five specified vertical

planes (dashed lines in the window between the coloured points.

Azimuth, N – E – S - W. Sometimes the horizontal direction of the vertical sections must be adapted to the gravity field to be

examined, because the modeling should ideally always be as perpendicular as possible to the main strike of the anomaly - this

ensures the greatest possible model gravity effect. You have the possibility to set a first rough adjustment of the direction via 

North - South - East - West.

2.3.1 How to import model geometry?
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West: the vertical sections run in N-S-direction 

2.3.1 How to import model geometry?
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South: the vertical sections run E-W-direction.

 In our example from the beginning, the vertical sections are aligned in the west-east direction and count from south to

north.

If you want to rotate it even more precisely, use the alphanumeric input in the azimuth window of the setting. In the example in

the next figure, 283 (270 + 13) deg. has been used.

2.3.1 How to import model geometry?
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Distance. The vertical sections to be created are indicated by dashed lines. Use the alpha-numeric input to modify the distance

between the vertical sections. Specification in km (as defined above for the input units). In the example, this would be approx.

317 km (316.85 km).

Count: Use the \< and > characters to decrease or increase the number of layers.

 In the example, the number of vertical sections has been doubled; the distance between vertical levels is reduced

accordingly to 133.94 km.

2.3.1 How to import model geometry?
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Press finish 

... and VOILÁ, our model appears in the IGMAS+ main window, defined by the 10 vertical planes in the central part of the

model and additionally a bounding section in the north and in the south - as it was entered earlier in the 2nd wizard window

(above).

The model can now be moved back and forth for viewing. Click into the model with the right mouse button and keep it pressed.

In this combination, move the model in the window. Moving the mouse wheel changes the zoom.

2.3.1 How to import model geometry?
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 Note:

The colours of the stratigraphic layers are set automatically by the program. How to change them is shown below (refer to 

Colors). We still have no stations, no reference gravity field and the model densities loaded.

But we can already have a quick look at the vertical sections. If you are interested, go straight to the item “show vertical cross

sections” below and return later to this position.

How to import reference gravity/gradient/magnetic field and topography/bathymetry?

Use the File > Import > Stations

Be sure to use the correct units and file type (.csv or .xyz)

2.3.1 How to import model geometry?
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In this input window you have the chance to assign different input parameters to the individual columns X - Y - Z. Column Z could

also contain gradients or a magnetic field size. "Measured z component" is selected correctly.

2.3.1 How to import model geometry?
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Press Finish 

2.3.1 How to import model geometry?
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The stations are placed in red on top of the vertical cross sections.

However, we do not yet have a basis for calculating the model gravity field. For this, two steps are necessary for preparation.

(1) Triangulate the vertical cross section, which results in a true 3D structure.

IGMAS+ offers the user two options:

Press either in the TITLE BAR > Edit > Model - Triangulation

or Press in the TOOL BAR 

Next you will see this wizard:

2.3.1 How to import model geometry?
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Press Next 

… and get from the program the following information:

2.3.1 How to import model geometry?
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 Check the messages in the table. Here possible errors during triangulation are indicated, but at the same time it is pointed

out that they will not be serious. This is a numerical instability in the visualization, which has no influence on the gravity

calculation.

PRESS Finish 

In the status information (below) the message will be shown that your model has no errors (green light), and we can proceed to

calculate the modelled gravity field.

To calculate the modelled fields, IGMAS+ offers two possibilities:

Click in the TITLE BAR >Tools > Calculate Anomalies

and select Calculate Anomalies.

2.3.1 How to import model geometry?
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or

press in the TOOL BAR 

and see the window:

Select the field component you will calculate and then

2.3.1 How to import model geometry?
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PRESS Finish 

Of course, the length of calculation time depends on the size of the model and the number of stations. Be patient with large

models!

The green "traffic light" of the "progress bar" in the “lower status line” gives you the certainty that everything has been

calculated correctly.

… then the time has come to see the modelled field and the model in perspective on the screen.

Very well done and that's done for now… 

2.3.1 How to import model geometry?
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2.4 Saving a project

Before we start to explore the model, the fields and their possibilities for representation, we should learn how a model and its

fields are stored. 

This should be done from time to time by the user himself.

IGMAS+ offers two types of storage (see below):

SAVE PROJECT and

SAVE AS ...

(1) The SAVE project action is initiated by a click in the TOOL BAR > “SAVE PROJECT”.

A window will appear warning you not to overwrite the current model version. If this is desired, click 

• 

• 

2.4 Saving a project
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IGMAS+ will create a new Model INPUT. Loading a model file in the next working phase you see that in the Timeline appears

the former model (in green colour) and the new model blue shaded:

If you click No, nothing will happen and the model will remain. CANCEL will terminate the action without any decision.

(2) There is a second possibility to save model changes.

Click on “File in the TITLE BAR*

2.4 Saving a project
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In the pull down menu appears (short key is “Strg+S” bottom).

“Save project” will save the entire model as already described above in (1).

 enables the user to give a new name to the model output.

Click on the “create a new folder symbol”  , rename the new folder and press “Save”.

2.4 Saving a project
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The small symbols indicate from left to right:

From left to right: 

Go one level up in the folder hierarchy - Go to home directory - Add a new folder - Show folders - Show folders listed.

2.5 Loading models

In the reverse case of loading a model that has already been saved, first select 

“Open Project”.

Open a version

When opening a project, several versions are displayed. These are all versions that have been saved earlier.

Select the following:

Dark or light interface appearance can be set by the user.

... and this also brings us to the next point in familiarizing ourselves with IGMAS+:

Note

2.5 Loading models
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2.6 Displays & visualization

Above, we have already introduced the 3D view. If you want to go through the model step by step (vertical cross section for

vertical cross section) then select on the IGMAS+ TOOL BAR under "Add Views", the item 2D View.

Add view > 2D View > click  

... and immediately the vertical section appears in the IGMAS+ Workspace window. Use pull-down menu “Add View”, select “2D

View” and the 2D view appears in the headline below the icons and the first vertical cross section of the model is displayed.

There are several ways to step through the vertical sections of the model.

(1) Use the ˄ (up) and ˅ (down) in the right upper part of the main window to step through the model.

2.6 Displays & visualization
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Now let's learn about two other options:

(2) Open the sections in the "OBJECT-TREE" window of IGMAS+ and select the section to be visualized (for example section 7).

Click with the right mouse button on the section symbol and select "View Section/2D" in the window. The selected section will

appear. Because each section must be clicked individually, it will take longer to view large models than with the method

described above.

The third possibility to visualize sections is realized via the "Map display".

2.6 Displays & visualization
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Add view > 2D Maps View (click)

Then the three maps appear that are active in the Object tree under "Fields".

Then the three maps appear (measured - calculated residial field), which are active in the object tree under "Fields". From left to

right you can see the map of the measured field, the modeled field, and the differences between the measured and the modeled

field.

A map enlargement can be seen in the next figure. Click with the right mouse button on the map layer and the window that

opens offers the possibility to draw the section (click "Show sections").

 NOTE: In the same way, other information can be selected in the same window. 

For example, "Show Stations", "Show Contours", etc.

2.6 Displays & visualization
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Click on one of the lines/vertical sections. It will be highlighted in red and the section name will be displayed.

Clicking with the right mouse button on the selected line opens the 2D view of this section.

2.6 Displays & visualization
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The default setting is always the perspective display of the reference field (measured field). The default setting is always the

perspective display of the reference field (measured field). This can be adjusted by clicking the following button in the TOOL-

BAR line:

Add view > 3D Model > click 

If the display of the comparison field is not desired, the user has the option to change this in the 3D display. In the following the

difference field is to be represented. A right mouse button click on "Residual Field" opens the window and one selects "Show in

3D":

2.6 Displays & visualization
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If you want to visualize the underlying information (e.g. positions of sections), you can change the transparency of the field

display. Go to "Fields" in the OBJECT TREE and activate "Property Editor" in the BODY MANAGER below.

Here you can change the transparency (using the slider). In addition, a "shading" of the surface can be created and an

exaggeration of the field.

2.6 Displays & visualization
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The value for exaggeration is always smaller than 1: ValExagg \< 1

2.7 Perspective of 3D Model

The 3D model can be displayed in two perspectives. The default is the perspective view. Modification: click with the right mouse

button in the model and select "View" in the window and select the perspective with the left mouse button:

2.7 Perspective of 3D Model
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A second, alternate procedure is:

Go to the line below the “TOOL BAR” and click the shown options for model perspective:

If all three types of display are selected, you will see below the TOOL BAR:

The three windows can be removed again by clicking on the X.

2.8 Zoom in, zoom out, move and place IGMAS+ elements

Click in the workspace window on the object to be enlarged/down sized.

ZOOM in with a movement of the mouse wheel t o w a r d s the user,

ZOOM out with a movement of the mouse wheel a w a y from the user.

This is generally true for all three "views:

• 

• 

2.8 Zoom in, zoom out, move and place IGMAS+ elements
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But click for 2D View in the model.

Click with the right mouse button on the object and moved it pressed:

Moving objects of: 

Click with the right mouse button on the model and moved it pressed up and down, to the left and right. The window with the

field curves will be placed correctly above the model.

Tilting a 3D View in its actual position: 

Click with the left mouse button in the workspace window and moved it pressed:

Center objects

Center model and 2D map views: 

Click with the right mouse button in the model, select "Center at" in the window and select the perspective with the left

mouse button:

2.8 Zoom in, zoom out, move and place IGMAS+ elements
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A second, alternate procedure is:

Go to the line below the “Tool bar” and click the shown options for centering the model:

Center 2D View:

Go to the line below the “Tool bar” and click the shown options for centering the 2D cross section:

The cross section (lower panel)) together with the field values above it (upper panel) is centered in the area where stations are

located.

2D View Section front/back side

In vertical cross sections that show the geometry of different bodies on their front and back sides (also called: double

occupancy), the two icons of the following figure determine whether the front side (left icon) or the back side (right icon) should

be shown.

2.8 Zoom in, zoom out, move and place IGMAS+ elements
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2.9 Change model geometry

If changes to the geometry of the model become necessary, the user can make model adjustments based on changes to model

vertices.

The actions Insert - Delete - Move vertices are described here.

Insert a vertex: 

Press key I-key  and navigate with left mouse button on the position of an interface/horizon > click .

Delete a vertex

Press shift key  and navigate with left mouse button on the vertex > click .

Be sure to see the coordinates of the vertex to delete on the screen:

Shift a vertex:

Press shift-key  and navigate with left mouse button on the vertex to be shifted > click .

Shift grouped vertices:

Press shift-key  together with the key . Then define region of vertices to be shifted by open a window with left

mouse button and move pressed left mouse button into the new position

2.9 Change model geometry
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Release the left mouse button. This is the result:

The model gravity field is automatically recalculated.

2.10 Split a body/polyhedron on a specific vertical cross section

Select "2D maps view"  and mark in the map the cross section on which the density of the body

should change (in ascending section number order). Here section 10 was selected; it is marked in red.

Alternatively, the vertical section can also be selected (1) in the OBJECT TREE or (2) by the "section up & down":

2.10 Split a body/polyhedron on a specific vertical cross section
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Click on the body to be divided (e.g. astenosphere) with the right mouse button and select "divide body".

The "divide body assistant" appears with the new name “Astenosphere new”.

Click "finish"  

2.10 Split a body/polyhedron on a specific vertical cross section
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In the PROPERTY EDITOR (lower left window) the list of updated bodies with their properties appears (here “volume” and

“density” are selected).

 Note these important points:

(1) The newly inserted body (Astenosphere new) still has the same density as the old one. The color has been selected by the

program and can be changed by the user (see section "Colors").

(2) Check the topology of the “new model”. Select Tools in the TITLE BAR and select “Check Topology”:

2.10 Split a body/polyhedron on a specific vertical cross section
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If now “error” is detected (normal case) continue with the next step. You may notice that the PROGRESS BAR (traffic light)

indicates red light:

Explanation:

The model has been changed and both triangulation and modeled gravity are no longer correct. Start with:

(3) “Model – Triangulation” to the new model. Select Edit in the TITLE BAR and select “Model-triangulation”:

Alternatively, the  icon can be used for model triangulation. Go to the TOOL BAR line and select .

2.10 Split a body/polyhedron on a specific vertical cross section
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(4) Re-calculate the gravity of the “new model”. Select Tools in the TITLE BAR and select “Re-calculate Anomaly”:

… and the PROGRESS BAR (traffic light) indicates green light.

If necessary, change density of the new body by “double click” on the density value and insert a new value:

PROPERTY EDITOR** 

> Body manager > double click” on the density of the new body 

**

2.11 Voxel Cube

The use of a voxel cube (density cube) also fits into the thematic environment of density changes. In IGMAS+, a voxel cube is a

cube consisting of many sub cubes. The size of the cube as well as the size of the sub cubes can be specified by the user. For

example, think of a velocity cube in 3D seismic. Quite analogously, the 3D density cube is used in IGMAS+. The densities of the

cube overlay the densities of the polyhedra/rock bodies in the three-dimensional modeling space. A typical application would be

to define a depth-depending or laterally changing density function to a sedimentary body, as shown in the figure below: the grey

colors indicate varying densities for the underlying rock density.

2.11 Voxel Cube
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The voxel function may also be used to calculate the anomalies of an imported seismic velocity cube, applying a function for the

conversion of velocities (normally Vp) into densities. If only the effect of an imported voxel cube has to be calculated, the

simplest IGMAS++ model, a cube, might be defined with constant density ρ = 0. Refer to the following figure for basic

information and to the IGMAS+ User Manual page 104.

2.11.1 Import/export and delete a voxel cube

 Note: only one voxel cube can be loaded in a current modeling. Any existing voxel cube must be deleted beforehand (see

below: Delete a voxel cube).

Select File in the “TITLE BAR” > click Import > select VoxelCube > click with left mouse button on it .

2.11.1 Import/export and delete a voxel cube
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Navigate in the new “Open” window to the directory where the file with the voxel cube is stored.

IGMAS+ provides several possibilities for navigation by the small icons at the right side of the directory pull down menu:

These icons allow the user to do the following – goto/show:

Up on level -

Home

Create new folder

List

Details:

Of course, you can also navigate to the desired directory with the ▼ next to the folder name; see next figure.

The “Open” window provides important information and enable the user to check the input data:

 Most important:

Does your voxel file have the extension “xxx.vxo”? If not, rename file before you continue!

 Units: Also important and often neglected

Ensure that units of voxel positions (x,y,z = depth) correspond to units of polyhedrons (either in meter or kilometers > or feet).

Select units in the pull-down menu “units” on the upper right of the “Open” window.

Leave all other settings as they are: for “Acceleration” (gravity field), “Gravity Gradient” and/or Magnetic Field.

In the next menu item of the OPEN window, the user decides how to proceed with any unoccupied voxel cube elements. The

default action is "Fill empty cells with nodata value". This means that IGMAS+ inserts numbers with unrealistically high values

(e.g. 1039) at the corresponding positions in the cube. If the alternative "Use interpolation to fill empty cells" is selected,

corresponding values in the cube are interpolated.

• 

• 

• 

• 

2.11.1 Import/export and delete a voxel cube
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The use of a CSV setting is strongly suggested. The separation of the values is indicated with "blank" in the example. In the

following it is still determined whether a header is placed ahead of the data of the voxel file ("Interprete Header") and/or whether

the cube values are separated with quotes ("use Quote for Values").

A few lines of the voxel cube input is given as an example for visual inspection. 

The columns contain from left to right: x-, y- and z-values (depths) of the voxel elements; note the direction of Z: it is negative

downwards . The last column shows densities of voxel cube elements.

 Here all lengths are given in km!!! Click on “km”  to select the correct unit.

2.11.1 Import/export and delete a voxel cube
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Otherwise, the data in the voxelcube file will be read in meters, with the consequence that the size of the voxelcube does not

match the size of the density model: the voxelcube becomes too small by a factor of 1000 per unit length.

If all input boxes are filled in, click on Open with the left mouse button. 

You get the window and sect “Density type” for gravity modelling and “Susceptibility type” for magnetic modelling; click

“Next” :

2.11.1 Import/export and delete a voxel cube
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You get the window “Model Voxellisation” which contains further specifications regarding the use of the voxelcube in the

context of combined Polyeder/Voxelcube - modeling. In the following INSET we explain the resulting possibilities for a correct 3D

modeling.

2.11.1 Import/export and delete a voxel cube
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INSET VOXELISATION

The Voxelisation is an important part of modeling with IGMAS+ and is quite different from other software packages > for

modeling potential fields. For example, it is possible to realize very elegantly 3D density changes with depth (for example by

compaction). The Voxelization function allows the user to take over a seismic velocity cube 1:1, whose velocities (Vp) in

densities are performed by means of self-created or predefined functions in the software.

We start with a textbook example which was elaborated by Sabine Schmidt (February 15, 2023):

On the right side of the above figure, a density distribution is given in t/m3 (2.6 - 2.4 - 2.8). This corresponds to reality (blue, Real

world). The middle figure shows the modeling conducted for this purpose (yellow, Model: Polyeder). We recognize that the

density distribution with 2.9 was modeled at a lower depth - thus outlining a deviation from reality. This deviation can be

corrected by blending a voxelcube model with the polyhedron model. This could have been determined from independent

measurements and contains the densities 2.4 - 2.6 - 2.4 -2.8).

IGMAS+ allows the user to blend the voxelcube and polyhedron model with a special input function. The voxel function is called:

*** "cellvalue - density" ***

and corresponds to the import of a voxelcube with density differences, which, however, are determined by the software >

independently of the user.

In the voxelcube domain, the "effective" densities are then obtained from the superposition of the polyhedron and voxelcube

models: the left side shows the difference formation, the right side the superposition of both for the two models.

The superimposed density model has the same effect as the "real world" density model. We call this "hybrid modeling" and take

advantage of the fact that the total density of all masses corresponds to the superposition principle. By dimensioning the voxel

size, extremely fine tuning can be achieved within the 3D density model. The computation of millions of voxels is possible without

lasting disturbance of the interactive processing or very long computation time.

2.11.1 Import/export and delete a voxel cube
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Let's move back to the description of the voxelcube input (voxelization window).

The window for Model Voxelisation

2.11.1 Import/export and delete a voxel cube
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For all geological bodies, special procedures for the use of the voxel cube can be defined here. Of course, this is only the case

where the voxelcube covers the polyhedra. If this is the case, minus density can be entered directly after "cellvalue"; cellvalue

contains the density element of the voxelcube element:

When entering a function, the user is supported by operators, mathematical functions, and the definition of constants.

2.11.1 Import/export and delete a voxel cube
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It is also possible to use pre-defined functions (to convert velocities into densities such as the Gardener and/or Nafe & Drake -

relations . These are provided for dimensioning the model in "meters/second" or "kilometers/seconds" and are used for the

conversion of seismic velocity models into density models. Click the three small dots.

It is also possible to formulate your own conversions and calculations using the instructions provided.

In the lower part of the voxelization window there are still three input possibilities to be explained:

(1) Equation Settings, (2) Unit and (3) 

2.11.1 Import/export and delete a voxel cube
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(1) Equation Settings allows the definition of a voxel function for

A L L geological bodies in the model. This is only useful if the voxelcube really covers all bodies.

(2) Unit: Here the units for the voxelcube densities are defined. Attention: the definition must not be forgotten, otherwise the

model gravity field will not be calculated correctly.

(3)  Here all those bodies can be hidden altogether (or switched on again), which are not covered by the voxelcube.

When all is defined, click FINISH 

2.11.2 Later changes of voxelcube functions

Regardless of the equation specified when importing the voxel (refer to the explanations before), the original cellvalue is always

saved and can be changed manually for each body independently later.

Select in Interfaces of the OBJECT TREE the body whose the cellvalue function should be changed (29_Mantle in the example)

and click: 

2.11.2 Later changes of voxelcube functions
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In the PROPERTY EDITOR body 29 is displayed with the

Body name

Voxel equation: cellvalue-density. 

If the user will change this function, click on the three small dots and an other window for the new input will be opened. If you

like, change cellvalue by the definition as before.

2.11.2 Later changes of voxelcube functions
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2.11.3 Export a voxel cube

Select File in the “TITLE BAR” > click Export > select VoxelCube > click with left mouse button on it .

In the Save window select the folder where the voxel cube will be stored under the user specified file name. Press “save” 

.

 

2.11.3 Export a voxel cube
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2.11.4 Delete a voxel cube

If you want to delete a voxel cube or replace it with a new (updated) one, click with the right mouse button on the letters of

"VoxelCube" in the "OBJECT TREE": the "Remove" window opens. Click with the left mouse button in the window and the

voxel cube will be deleted from the model visualization (Screen).

 

 Important:

However, the gravity effect of the voxel cube is not yet eliminated from the overall gravity field of the model. The next section

explains how to delete the gravity effect of the voxel cube from the modeled gravity field. See the section "Use/invert Cube

anomaly" at the end.

2.11.5 Voxel cube effects and their visualization

Information about the voxel cube can be obtained by clicking on "VoxelCube" in the "OBJECT TREE" and then activating the 

PROPERTY EDITOR (window at the bottom left). Click on VoxelCube then you see this screen  :

2.11.4 Delete a voxel cube
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2.11.5 Voxel cube effects and their visualization
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The window shows the name of the used voxel field (in light grey). The “Transparency” slider controls the transparency of the

voxel cube in the “WORKSPACE WINDOW”.

“Cube Type” indicates either a density or susceptibility voxel cube.

“Algorithm” provides information on the calculation of voxel cube effects. In the example above a Newton Fast Fourier

(Newton FFT) method is set calculating on multi cores. This is a fast and normal procedure. More information/other methos

are available if you press the three small dots right of “Algorithm”. The “Voxel algorithm Wizard” opens:

• 

• 

2.11.5 Voxel cube effects and their visualization
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We read that a CPU multicore implementation is active and the (gravity) effects of mass points are calculated in the wave number

domain (FFT).

 Again, this is a fast method to calculate the gravity effects. Other methos are also available after clicking the pull-down

menu “Algorithm”:

Newton mass points calculation by OpenCL or

Prism calculation (both multicore and OpenCL) or

Gauss Quadrature (both multicore and OpenCL) even

Spherical Newton mass point calculations are available if calculations are spherically done.

One can also extend the FFT grid.

If you click in the “Voxel algorithm Wizard” on the item “Interpolation Type” (Refer to the last image, left side) the types of

interpolation are listed. An interpolation is necessary to transfer the calculated values at the FFT nodes to the measuring

stations.

There are three methods to choose from:

Kernel (3x3) Mundry interpolation,

Nearest neighbor and

Kernel (3x3) average interpolation.

• 

• 

• 

• 

• 

• 

• 

2.11.5 Voxel cube effects and their visualization
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 Kernel (3x3) Mundry interpolation is robust and reliable.

If stations are located in a constant height, click on “Use Constant Station Elevation”.

Click “Finish” 

Activate “VoxelCube” and go to the “PROPERTY EDITOR”

The item “Use/invert Cube anomaly” in the PROPERTY EDITOR plays an important role. If it is “true”:

2.11.5 Voxel cube effects and their visualization
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the gravity effects of the voxel cube and the polyhedrons are calculated at all stations; if it is “false”:

And the gravity of the polyhedrons will be calculated without the effect of the voxel file.

2.12 Modify model parameters (densities/susceptibilities)

We already knew this action when it came to changing the density/susceptibility of a new body (see also " Split a body/

polyhedron on a specific vertical cross section ").

2.12.1 Change densities/susceptibilities

Select in the window of BODY MANAGER / PROPERTY Editor (bottom left) and select Body manager.

The names of the existing model bodies are displayed with their selected colors. Then follow from left to right "voxel factor",

"density [t/m^3]", "volume voxels [km^3]" and "volume polyhedron [km]". What of this information is displayed, the user can

specify

by clicking the small  in the right corner.

The various parameters can be changed in their horizontal position: Click with the left mouse button on the parameter to be

moved and drag it to the desired position with the mouse button lowered.

Double left mouse click  on the body (here upper mantle) where the density/susceptibility is to be changed

and type in the new density alpha-numerically.

2.12 Modify model parameters (densities/susceptibilities)
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 Note: The resulting change in model gravity is displayed immediately, that is, the density change is performed

automatically by the program.

The definition of „reference density“ is import because it minimizes the edge effect” of the model. Always set the reference

density so that the edge effect is a minimum! Try this out on your model.

2.13 Density Inversion

Besides the possibility to change densities directly by the user, IGMAS+ also offers the possibility of an automatic calculation

(inversion).

 ATTENTION: the inversion does not make sense if all or very many densities are to be changed in a model. The system of

equations would then have too many parameters, is overdetermined and the result is meaningless. You have to try it out! One or

two densities should be allowed for an inversion (out of about 10 model densities).

The MMSE method is used in IGMAS+. MMSE stands for “Minimum Mean Square Error” and utilizes the mean square

approach and Gaussian random variables within a statistical framework.

(Refer e.g. to: C. Haase, Dissertation, Uni Kiel, 2014:

https://macau.uni-kiel.de/servlets/MCRFileNodeServlet/dissertation_derivate_00005626/diss_haase_2014.pdf)

Select in the TITLE BAR “Tools” among other important program activities – we already know – klick on “Parameter

inversion (MMSE). Here is what you see:

2.13 Density Inversion
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The next window opens:

First, one has the possibility to select the density-inversion by means of Gravity and/or Gradients”; with “Magnetic” one

would make an inversion of susceptibilities (no susceptibilities exist in this example); refer to figure above.

To modify the error given for the field(s) (here 0.2 mGal) refer to scenario “Change error of measured fields” in last wizard.

2.13 Density Inversion
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At the right side of the above window, under the tab "IGMAS effect", the inversion of densities of polyhedra is to be selected

(figure above). To set and/or to modify the standard deviations for the different densities in the menu above (STD: 5.0 t/m3) refer

to scenario “Change standard deviation of densities/susceptibilities” below. For the inversion it will be sufficient in most

cases to leave the values (STD) unchanged.

Otherwise, the densities of the voxel cube “Voxel Effect” can also be inverted (next figure).

To set and/or to modify the voxel factor (here 1.0) and the variance/STD 5.0) for the different bodies in the menu above refer to

scenario “Change standard deviation of densities/susceptibilities” below. For the inversion it will be sufficient in most cases

to leave the values (“voxel factor” and STD) unchanged. The “voxel factor” is explained in detail in the scenario “Voxelcube).

Below under “settings” you can switch off or switch on  the of geological bodies listed above.

Invert the densities of polyhedra “4Astenosphere” and “reference” (under IGMAS Effect). All bodies under “Voxel Effect” are

disabled now:

2.13 Density Inversion
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Click Next and the result will be presented in the next window  :

Click Finish to accept the new densities 

2.13 Density Inversion
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.

The upper panel lists the densities before and after the inversion and the lower statistics panel shows the standard deviations

(before/after) and the Pearson correlation coefficients. Since the correlation after the inversion is better than before, the result of

the inversion was accepted.

In the other case, by clicking on "Previous", the user would have the possibility to select other bodies, respectively to change the

standard deviations and errors.

 Attention:

To change standard deviations and errors, the inversion must be canceled. It is not possible to change the above parameters in

the inversion window.

2.13.1 Change error of measured fields

Click in the OBJECT TREE on “Gravity z-component”. Then select Property editor

And select one of the icons  :

Click on “error gz” and then on “Value”. Double click with left mouse button

Enables the user to input a new value for the error of measured gravity field.

2.13.1 Change error of measured fields
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2.13.2 Change standard deviation of densities/suceptibilities

Click in the OBJECT TREE on “Gravity z-component”. Then select Body Manager.

2.13.2 Change standard deviation of densities/suceptibilities
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You will see a window like this; (be aware: this here is only a snippet):

In the next step it is important to move the displayed parameters so that the items to be changed are visible. To do this, the

window can be enlarged (keep the left mouse button pressed on the right edge of the BODY MANAGERS and drag it

larger...).

Then, by clicking the ICON above right corner, a selection of the parameters can be made. Now it is important that Standard

deviation is selected - for the density or for the susceptibility.

This results in the next screen:

… and after moving/sorting the parameters by pressing left mouse button and moving them into another position in the BODY

MANGER, we see:

2.13.2 Change standard deviation of densities/suceptibilities

- 70/122 -© 2024 - Helmholtz Centre Potsdam - GFZ German Research Centre for Geosciences

../media/cac230ee97d44dad86d0649350058ade.png
../media/cac230ee97d44dad86d0649350058ade.png
../media/cfb8fd55a1fbed2ce221fd3aa247570b.png
../media/cfb8fd55a1fbed2ce221fd3aa247570b.png


To select a new Standard deviation for the density/susceptibility of one of the geological bodies

> click on the body  > and then on “Add Parameter” 

In the small window that is displayed you may select the correct units (here t/m^3) and the type you will change: “Density

Standard Deviation”:

... finally double click with the left mouse button on body and include the new value:

2.13.2 Change standard deviation of densities/suceptibilities
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In the same way, the other parameters can be changed - for example, the "Voxel Factor", which can also be inverted. In this

case, the "Voxel Effect" tab must be activated in the "Inversion" window (see "DENSITY INVERSION" above).

2.14 Colours

Colors are used in IGMAS+ in two very different areas:

- (1) For the differentiation of bodies (geological structures) or

- (2) in the map representation of the used fields.

2.14 Colours
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For the differentiation of bodies (1) the program distinguishes between two color schemes:

either the (geological) bodies are filled according to the colors known in geology (e.g. blue for Jurassic, green for

Cretaceous and yellow for Tertiary rocks) or

the colors are determined according to the density of the body. Blue colors correspond to high densities of rocks, 

brownish colors to low densities.

This color spectrum is automatically set by the program and is based on the color scale used to create the residual gravity

maps. In the current IGMAS+ version, the user does not have the possibility to change the scaling or the colors of the color

scale. You can see the color palette (Vik) here; the way to get there is described in this chapter below.

 Note: At the beginning of a modeling project IGMAS+ automatically sets the colors for geological bodies. They must then

be changed by the user according to the two color schemes.

2.14.1 Change colors for geological bodies/polyhedrons

Be sure to have selected the “Normal Color Mode” after clicking View in the TITLE BAR > “Body Color Mode” in the

popped-up window > and set “Normal Color Mode”.

• 

• 

2.14.1 Change colors for geological bodies/polyhedrons
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If the colors for the susceptibility of the bodies are to be set, then of course "Susceptibility Color Mode" must be selected in

the window shown above. The process is analogous to the selection of the "Normal Color Mode".

Select “Add View” in the TITLE BAR and klick on “2D View”. Below the TOOL BAR the icon for “2D View” is set:

Then go to the “Object tree” (top left), click on  to open the "Interfaces" tree 

and select the body whose color is to be changed (here: 032_con_Sed_Po; blue bar):

2.14.1 Change colors for geological bodies/polyhedrons
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... go to the „Property Editor“ > click in the opened menu in „Body“ and „Color“ > click on the small color window and click on

the three grey points :

2.14.1 Change colors for geological bodies/polyhedrons

- 75/122 -© 2024 - Helmholtz Centre Potsdam - GFZ German Research Centre for Geosciences

../media/ea226873155072251e14a938ca8facb6.png
../media/ea226873155072251e14a938ca8facb6.png
../media/f089387752bf8dcc5973866645c1bbea.png
../media/f089387752bf8dcc5973866645c1bbea.png
../media/1a2a3dcd82746dcdfd4401a2b89d8490.png
../media/1a2a3dcd82746dcdfd4401a2b89d8490.png


The color is also identified in the RGB color scheme (R:102 - G:204 – B:255).

Clicking the three grey points (figure above) this window popped up:

Select by clicking a new color :

2.14.1 Change colors for geological bodies/polyhedrons
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Alternatively, the colors can be changed in this window using the HSV - HSL - RGB - CMYK color scales. The effect is the same

everywhere.

2.14.2 Change colors for IGMAS+ maps

The color palettes used in IGMAS+ for map display follow new findings regarding the physiology of perception of healthy and

visually impaired people (see for example:

https://theconversation.com/how-rainbow-colour-maps-can-distort-data-and-be-misleading-167159.

IGMAS+ uses two options for selecting different color palettes for displaying the comparison field (measured gravity/magnetic

field) and the modeled field (calculated) on one side and for displaying the residual field on the other.

Selection of the color palette for measured and modeled field

Select “Add View” in the TITLE BAR and klick on “2D Maps View”. Below the TOOL BAR the icon for “2D View” is set:

Three maps are shown: 

Measured field (left) ------------------------------------------ Calculated field (middel) ---------------------------- Residual field

(right)

Select below the TOOL BAR on the right upper corner the icon  and select the tab “meas Gz/calc

Gz”.

Get a window which visualize the Batlow palette.

2.14.2 Change colors for IGMAS+ maps
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By click on  of the Colormaps, other palettes may be selected:

2.14.2 Change colors for IGMAS+ maps
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 Note: The selection of the Batlow palette represents a good compromise, in terms of the previously often traditional

"rainbow colors" palette and the currently recommended.

To select the color palette for the residual field/”Residual Anomaly” select the tab “Residual Anomaly”:

2.14.2 Change colors for IGMAS+ maps
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The Vik palette is grouped around a central value (here: the Null value of the residual anomaly).

By click on of the Colormaps, other palettes can be selected. 

2.15 Save project

At the end of each working phase, but also frequently during this process, it is advisable to save the model.

(1) This action is initiated by a click in the toolbar “SAVE PROJECT”.

2.15 Save project
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A window will appear warning you not to overwrite the current model version. If this is desired, click   

IGMAS+ will create a new Model INPUT. Loading a model file in the next working phase you see that in the Timeline appears

the former model (in green colour) and the new model blue shaded:

2.15 Save project
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If you click NO, nothing will happen and the model will remain. CANCEL will terminate the action without decision.

(2) There is a second possibility to save model changes.

Click on “File” in the TITLE BAR

2.15 Save project
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In the pull down menu appears  (short key is “Strg+S” bottom) and .

“Save project” will save the entire model as already described above in (1).

“Save as” enables the user to give a new name to the model output.

• 

• 

2.15 Save project
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Click on the “create a new folder symbol” , and ... 

rename the new folder and press “save”. 

2.16 Export Results and Model components

IGMAS+ does not provide the user with direct tools for printing model components and fields (calculated, measured and

residual fields). It is not necessarily the task of an interactive modeling software to offer all possibilities of a modern graphics

processing. However, in order to take advantage of this, there are a number of possibilities for the user to further process 

IGMAS+ results with this other software.

Clicking FILE in the TITLE BAR select “Export” and get information on the components to export:

2.16 Export Results and Model components
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IGMAS+ offers seven Export actions: 

(1) Borehole(s), 

(2) Model, 

(3) Stations, 

(4) Interface(s), 

(5) Voxelcube, 

(6) Border-VoxelCube and 

(7) StressMap. 

The exports are alpha-numeric and are used for further processing of the model results in external software.

2.16.1 (1) Borehole(s) (To be done)

2.16.2 (2) Model

After clicking this wizard appears on the screen.

• 

• 

• 

• 

• 

• 

• 

2.16.1 (1) Borehole(s) (To be done)
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 ### Note: There is currently only one file type available: XML (Extensible Markup Language).

Click: Save  

In the selected folder in your PC folder structure you will find the new file My model.model:

The file is opened with an editor and the entire model structure with the IGMAS+ geometry, the fields and other components

can be seen in plain text:

Here we show snippets from the relatively large XML file:

2.16.2 (2) Model
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2.16.3 (3) Stations

In contrast to the model export, we select [csv] [xyz] - Comma Separated Values, which can be used in many external

computer programs for further processing.

2.16.3 (3) Stations
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Make sure that the units of the station data (here: meters), the acceleration/gravity (here: mGal), the gravity Gradient(s) and

or the magnetic Field are specified correctly according to the modelling. In the separator field, "blank" (used in the example

above) or a tabulator can be used.

Click: Save 

… and above the progress bar (bottom right of the screen) you will read the information that the stations were successfully

saved:

In the selected folder in your PC folder structure you will find the new file

My stations.model:

2.16.3 (3) Stations
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This file is much smaller than the saved “Model file” and looks like this:

"x" "y" "z" "measured z component" "calculated z component" "residual z component"

When continuing to process the station file externally, you should make sure that the software can process the header in the

station file.

2.16.3 (3) Stations
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2.16.4 (4) Interface(s)

Select in the TITLE BAR Export > Exort > Interface(s) 

and get the screen:

2.16.4 (4) Interface(s)
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Check "the file "My Interfaces:

2.16.4 (4) Interface(s)
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This ia large file (22 MB); here we prsent a short parge only to get information on its structure. 

2.16.4 (4) Interface(s)
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2.16.5 (5) Voxelcube

2.16.5 (5) Voxelcube
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The saved Voxelcube always has the extension ".vxo". The file can be renamed without problems and get the extension ".txt" -

then it can be read with any editor.. The file-header and the first lines of the file look like this:

2.16.5 (5) Voxelcube
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2.16.5 (5) Voxelcube
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2.16.6 (6) Border-Voxelcube

to be added

2.16.7 (7) Stress map (to be done)

2.17 Miscellaneous

2.17.1 Switch on and off fields

Refer to OBJECT TREE an select Fields. If you don't want any fields to be displayed at all, uncheck the box with the blue

checkmark  in front of Fields. If fields are to be displayed, then expand the tree under Fields, by clicking on . By unchecking

the blue tick boxes in front of the corresponding fields (calc Gz or meas Gz or Residual Anomaly), the corresponding field can

then be switched off/off respectively.

2.17.2 Point information of model parts

In addition to the Property Editor and Body Manager, there is also the Information Tab. Click on Information > move the mouse

over the screen. The window now shows the information about the respective item.

2.16.6 (6) Border-Voxelcube
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2.17.2 Point information of model parts
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2.18 IGMAS+ Shortcut table
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2.18 IGMAS+ Shortcut table
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3. Tutorial

3.1 Tutorial

You can’t blame gravity for falling in love

― Albert Einstein

3.1.1 Preface

This tutorial provides a basic working concept of IGMAS+ when used to investigate gravity and magnetic fields, including all

aspects that need to be considered when starting an IGMAS+ project. It is intended to bridge general textbook knowledge on

gravity modelling with the specific “how-to” information given in other chapters. Hence, it provides both key words from the

gravity research field (without repeating textbook contents) and definitions for IGMAS+ specific terms which can be further

looked up in the documentation.

3.1.2 Potential fields

IGMAS+ calculates both fields of the potential methods: the gravity field and the magnetic field. It is user friendly and allows

very fast calculations. In this tutorial we focus on the explanations with gravity field modelling. The calculation of the magnetic

field of geological bodies is equivalent: one replaces the rock parameter "density" by the rock parameter "magnetic

susceptibility" or, where it is necessary, by the "remanent magnetization" of rocks. All explanations are valid for modelling with

both fields.

3.1.3 Gravity anomalies

Gravity anomalies - i.e. deviations from the normal field or theoretical gravity field of the Earth,

provide us with insights into the geological structure and related density distribution of a region.

For a specific gravity anomaly, or, more realistically expressed, for an ensemble of anomalies to be explained, however, an infinite

number of density distributions can theoretically cause these anomalies (see Figure).

Quote

Δg= gmeasured−γnormal

3. Tutorial
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Non-uniqueness of gravity interpretations. Three differently shaped

bodies with density ρ2 are embedded in a material of lower density

ρ1. The gravity anomaly above the section corresponds to only one of

these bodies and shows a central high due to the density difference

given. Without any other independent information (constraints) it

cannot be concluded, which of the ρ2-bodies is responsible for the

observed gravity anomaly.

Note the ambiguity of all potential field observations!

It is essential to the modelling philosophy of IGMAS+ to overcome this ambiguity by means of gravity-independent observations

(constraints). With this software package, Free Air, Bouguer- and geoid anomalies can be modelled (among others: Götze and

Lahmeyer, 1988, Schmidt et al., 2011, Schmidt et al., 2020).

At the beginning of each modelling, the user should decide whether to work with Bouguer or Free Air anomalies:

work with Free Air anomalies if no terrain and Bouguer slab corrections were calculated before and

work with Bouguer anomalies if both corrections had been applied to measurements.

This is an important decision, because the model must be built accordingly. IGMAS+ does not calculate one or the other

anomaly, but the static part (attraction) of the gravity field of an Earth model, a sedimentary basin, a cavity or a mountain range

which are represented as an ensemble of three-dimensional closed density bodies. For the following it will be agreed that the

geophysical term "Free Air anomaly" is equivalent to the geodetic term "Disturbance".

Free Air anomaly (disturbance in geodesy):

Bouguer anomaly:

• 

• 

FA = gP −γ+δgF

BA = FA −δgB

3.1.3 Gravity anomalies
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with:

 -- observed/measured gravity value at station 

 -- normal gravity at the ellipsoid

 -- Free Air correction (normal gravity at station )

 -- Bouguer mass correction (gravity effect of masses between the station  and the ellipsoid)

The cartoon illustrates the diverse processing steps which are necessary to calculate gravity anomalies.

• gP P

• γ

• δgF P

• δgB P

3.1.3 Gravity anomalies
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This cartoon visualises the various steps required to compute a

geophysical anomaly and the resulting changes in the processed

gravity field. The individual images are to be read from top left to

bottom right. They are taken from a presentation by Ron Hackney &

Hajo Götze (pers. comm.)

3.1.3 Gravity anomalies
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Calculation of ,  and  is not a part of IGMAS+ modelling and must be performed in advance.  and  are called

correction terms, sometimes also ''reduction'' terms. The user should look more closely into these correction terms while using

downloaded gravity fields from the ICGEM website.

IGMAS+ allows users to fit measured gravity observations to 3D and 2D density models and interactively compare the

calculated fields to the observed anomalies. We mention ''observed anomalies'' and by this mean that comparative values of the

gravity fields can originate from two different sources:

Specific processed field measurements, or

Global models like those available on the ICGEM website.

Please refer also to the remarks on the use of the ICGEM gravity datasets.

To obtain an interactively optimized fit between calculated and observed anomalies, users can:

manually adjust a density configuration by changing the density values and the geometries of density bodies

automatically invert a gravity field for a density configuration.

In this workflow, gravity independent observations (such as geological maps, borehole information, seismic velocities and

discontinuities, cross sections derived from other geological and geophysical interpretations, etc.) are integrated at two stages:

when defining the density configuration of an initial 3D model and

when interactively modifying the model while simultaneously visualizing the independent constraints.

Common to all inverse approaches, the number of the "free" parameters (degrees of freedom) in the modelling process should be

significantly reduced before the final forward field matching, respectively inverse density calculation. For example, the final

modelling step may be limited to the adjustment of the thickness and the lateral extent of a model unit with the pre-defined

density (variation). Fixing as many other parameters of the initial 3D density model as possible requires the input data of

appropriate spatial coverage and (in the best case) "old familiar" uncertainties. On the other hand, the model should be kept

simple, in other words, one should choose complexity just to be able to answer a properly defined scientific question.

Remember:

A model which images any detail of the reality is as useful as a map of scale one to one.

― Joan V. Robinson

Note also the different scales for the individual results of the gravity calculations. This procedure must be done by the user

before modelling.

2024-01-31
 

γ δgF δgB δgF δgB

• 

• 

1. 

2. 

1. 

2. 

Quote

3.1.3 Gravity anomalies
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3.2 Setting up a density model

Lorraine, my density has popped me to you.

― George McFly, Back to the Future, 1985

For the modeller, each compilation of a density/susceptibility model always consists of two activities that result from a theoretical

approach: a body must be defined which contains a mass/magnetic material (here density and/or susceptibility), and the

distances from stations where the gravity and/or magnetic fields were measured. Therefore, model stations must be defined (see

below).

At first, the origin point of the model (its zero point) has to be fixed, which is not only the origin of model geometry, but also of

model stations, of the corresponding gravity/magnetic fields which should be matched, of the voxel cube and of any available

additional map information, for example from a geographical and/or a digitized geological map.

We start with the explanation on how to handle the bodies and densities and continue with the explanation for stations.

3.2.1 Model bodies

In IGMAS+, density in space can be defined either in terms of

triangulated polyhedra surrounding a certain volume of constant density, or

a 3D voxel cube containing numerous voxels, each carrying its own density value.

A model with two polyhedra of constant densities (pink and red).

Quote

1. 

2. 

3.2 Setting up a density model
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A voxel model defining sedimentary density structures.

All polyhedra with the same density definition make up a model body (Body Manager), while a single model body may be divided

into several geometrically separated polyhedra (called "indexed body parts"). The hull of a polyhedron is composed of

interfaces and the geometry of each interface is defined by vertices.

The user-defined positioning of these vertices is crucial for the triangulation process by which IGMAS+ geometrically

approximates the 3D density structure.

The obtained model topology is defined based on the position of such vertices on pre-defined, parallel oriented, vertical planes

(vertical working sections).

Illustration of basic terms for IGMAS+ model construction: vertices

(black points), triangles (black lines), and working sections (vertical

planes).

These working sections are the virtual scenes for implementing any interactive modifications of model geometries, for example,

by adding, deleting, or moving vertices.

3.2.1 Model bodies
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In case the model is built on working sections, there are no vertices located between the working sections. The user therefore

should define the number, spacing and horizontal orientation (strike direction) of these working sections:

to keep sufficient control of model geometries throughout the interactive modelling process, and

to allow for a proper analysis of elongated gravity anomalies (i.e., orient working sections perpendicular to the strike of major

anomalies).

Working sections are always parallel:

Four steps that are important when defining the geometry of the

model bodies by “sections”. (a) Decide which anomalies should be

modelled. (b) Select the area to be modelled. (c) Mark the sections

on the area to be modelled and define the intersections of the

sections with the anomaly. (d) Consider which of the sections and the

intersections are really important to model the anomaly correctly.

Remember: the simpler the model - the better it is.

1. 

2. 

Tip

3.2.1 Model bodies
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IGMAS+ calculates gravity effect either for a flat or a spherically curved model. The latter is required for very extensive model

domains. To get an impression of the Earth surface "depression" of a spherical model compared to a flat one, note the following

numbers:

In addition, it should be considered that in a spherical model the calculation of the direction of the vertical component changes

continuously according to the curvature of the Earth because it always points to the centre of the Earth. Thereby, a spherical

model assumes that the Earth is approximated by a sphere; an elliptical shape cannot yet be realized (but this is negligible for

many lithosphere modelling applications). Test calculations have shown that for a model extending by, e.g.,  km  and

reaching a depth of  km, there is a difference in calculated gravity between a spherical and flat modelling approach of about 

m/s (  mGal).

Depending on the user’s objectives and the characteristics of gravity/magnetics independent information at hand, there are

basically three different ways of building up an initial 3D density model ready to be analyzed in terms of its gravity/magnetics

effects:

a) “Defining sections” approach: define working sections before loading or creating model vertices.

b) “Loading layers/interfaces/horizons” approach: load point sets forming body interfaces before defining working sections.

c) “Loading a voxel cube” after defining the model space according to (a) or (b)

When selecting the “sections” approach (a), the user builds the model from scratch by first defining the 3D model extent and

the vertical (working) sections and then loading or creating vertices to construct interfaces that separate bodies of different

density. Any gravity-independent data which are loaded into the obtained model space to help constructing the density

bodies (e.g., bitmaps, point sets) can be projected and visualized on the vertical sections.

In this case, the sections should be appropriately positioned to keep the projection-related distortions of observed structures

small. Since all vertical sections need to be parallel, it might not be possible to represent all available structural information

ideally in the model domain. Hence, option (a) suits well to solve generic problems independent of correctly geo-referenced

structures. Additionally, the approach may be selected if the spatial coverage of gravity-independent structural input data (e.g.

seismic profiles, boreholes) is very limited with respect to a larger number of observed gravity anomalies. For example, the

interpreted structure of a single 2D seismic section could thus be continued laterally by inferring a variety of consistent 3D

models from the observed gravity field. Thereby, one would strategically start with a simple density configuration and increase

the model extent and complexity stepwise.

If the spatial coverage of structural input data is dense enough and the depth/thickness configuration of several density bodies

can be derived directly and modelled outside of IGMAS+, then the “layer” approach (b) offers the proper functionality. In this

case, the user can load continuous interfaces or horizons -- sets of regularly or irregularly spaced points with XYZ coordinates.

Each horizon defines the top of a spatial domain that -- according to gravity-/magnetics-independent observations -- has been

identified as a potential contrast in density with respect to adjacent domains. The loaded interfaces/horizons are stacked by

IGMAS+ and collectively define the default 3D model extent (to be changed optionally), while the working sections are defined

only after this stage. As part of the model building process, IGMAS+ interpolates between the loaded XYZ points of a horizon,

derives the intersections of the horizon with the working sections and accordingly creates a number of vertices positioned on the

latter. Hence, the initially loaded point sets are not identical with the final vertices representing a horizon! Care should be taken

that the horizons/layers/interfaces do not intersect each other (corresponding to a negative thickness of the respective layer in

between).

Generally speaking, there are no specific suggestions for the use of case (a) or (b). Recently, there has been some preference for

the use of case (b), since many modelers prefer to work with predefined layers from open databases (for example CRUST1.0, 

Distance [km] Depression [m]

10 7.85

50 196

100 784

200 ~3000

250 ~5000

2000×2000 2

200

20−25×10−5  2  20−25

• 

• 

• 
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LITHO1.0, ETOPO1 and many others). Layers cannot be eliminated from the model afterwards. But you can assign the same

density to the horizon as to its neighbouring horizons, to the side of it, above it or below it. Then it has no more gravity effect on

the model stations.

After setting up a model either following approach a) or b), one or several model bodies may be selected for “voxelization”

approach (c), i.e., for being differentiated into numerous voxels, each carrying its own density value. In this way, smaller-scale

density variations derived from independent observations (e.g., seismic, mineralogical-petrological) can be superimposed on the

geological structure and considered for the gravity calculation. Each voxel is associated with an effective density representing

the sum of:

a constant body density, and

a voxel density.

One way of defining the voxel density is to first create a voxel grid and then apply a certain function to implement physical laws

or empirical concepts such as seismic-velocity-to-density conversions or depth-controlled porosity-density functions.

Alternatively, the voxel cube may be defined completely by data import including both the coordinates and density values of the

voxels. Additional IGMAS+ functionality related to voxel cubes is provided in terms of:

multiplication of the voxel density with a voxel factor for fast model modifications,

automatic edge effect minimization and

transformation of voxel-related density variations into triangulated isosurfaces.

Currently only one voxel cube can be applied to an IGMAS+ model.

3.2.2 Model densities

Concerning the density value assigned to each model body, it does not matter if absolute or relative density values are chosen,

since the resulting gravity effect only depends on the density differences at modelled interfaces and the distances from stations.

This implies that gravity modelling alone cannot determine absolute values of densities.

For a deeper understanding of these statements, a more detailed description of the basic mathematical-physical formulas for the

calculation of the gravity effect in IGMAS+ would be beneficial. However, this would go beyond the scope of this tutorial.

Therefore, the original publications by Götze and Lahmeyer (1988) or by Götze (2014) are recommended.

3.2.3 Model stations

The observed and calculated gravity fields are defined at the stations, each being defined by its  coordinates. The station

height ( ) refers to its elevation with respect to the geoid, in case of elliptical coordinates -- also to the ellipsoid. It either

represents the vertical position of the original gravimeter measurement (daylight surface for terrestrial data, height above the

sea level for ship data, flight height for airborne and satellite data, etc.) or a reference level to which the acquired remote data

have been continued (see chapter "Fitting gravity anomalies" and Figures for CBA (simple), FA (simple) and FA (difficult)). The

only condition that must be met for the height of all stations is that they must be located above all model masses. It has its

meaning for modelling exclusively when using Free Air anomalies.

1. 

2. 

1. 

2. 

3. 

Note

XYZ

Z

3.2.2 Model densities

- 108/122 -© 2024 - Helmholtz Centre Potsdam - GFZ German Research Centre for Geosciences

https://doi.org/10.1002/2013JB010626
http://dx.doi.org/10.7289/V5C8276M
https://igmas.git-pages.gfz-potsdam.de/igmas-pages/publication/goetze-1988
https://igmas.git-pages.gfz-potsdam.de/igmas-pages/publication/goetze-2014


Practical experience and examples for heights of the user-defined reference level  can be found here:

Note that to avoid numerical/theoretical problems (namely, local outliers in the calculated gravity), the stations should neither be

located inside a model body nor precisely on its edges or surfaces (hence, check the  values with respect to the top of the

uppermost model body).

In case of doubt, add  cm to the height of the body surface -- the height of the gravimeter measuring system (see Figure).

The spatial coverage and spacing of the stations (i.e. their  coordinates), together with the wavelengths of the associated

observed anomalies, provide limits to the scales and resolution of subsurface density heterogeneities that can be derived -- an

important aspect when planning a gravity modelling project.

In the context of resolution, IGMAS+ allows gravity calculations for a large number of stations -- but user should keep in mind

the memory size limit.

In general, there are two different types of station data that IGMAS+ users may use: irregularly or regularly spaced data. When

working with original irregularly spaced measurements (i.e. scattered and clustered  station coordinates), the observed and

the modelled gravity have the same relative position with respect to the causative density bodies. If one chooses to interpret

anomalies that have been transferred to a regular grid (e.g., by use of ICGEM data sets, or other grids), however, one accepts

that the model bodies have a smaller effect with respect to the stations than the real bodies due to interpolation procedures.

Hence, it is generally recommended to use irregularly distributed stations instead of gridded gravity data.
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Mountain range Top mountain Minimum height

of the reference level (m)

European Mittelgebirge 

(low mountain ranges)

Brocken (Germany) 1500

Eastern Alps Großglockner (Austria) 5000

Western Alps Mont Blanc (Italy/France) 6000

Andes Aconcagua (Argentina) 7000

Himalayas Everest (Nepal/China) 8000

Z

13

XY

XY
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3.3 Modelling field components and gradients

IGMAS+ allows modelling of the three components of gravity ( , ,  ) of which , the gravity field, is typically used for

density modelling. In addition, the six independent tensor components of the gravity gradient ( , , , , ,  ) can

be calculated.

Gradients provide a higher resolution than the vertical component of the gravity field. The calculation of gravity mass effects

require:

a successfully triangulated model geometry,

bodies to be assigned with density values, and

stations to be located in the study area.

As just described for the gravitational field, modelling of the Earth's magnetic field ( ) is also possible if the modelling parameters

are given (i.e. triangulated model bodies with defined magnetic susceptibility but also magnetic remanence). IGMAS+ thus yields

the three components of the magnetic field ( ,  and ) and the six independent gradients for the magnetic field components

( , , , ,  and ).

IGMAS+ uses the algorithm of Götze and Lahmeyer (1988) to calculate the effect of a homogeneous polyhedron on gravity by

transforming the volume integral into a sum of line integrals by the application of theorems of potential theory. The fields are

first calculated for each station and each interface (i.e. the set of triangles separating two bodies) separately and then the effects

of all interfaces are summed up to obtain the total amount at a station. 

Likewise, the anomaly effect of a voxel model is calculated independently and then added to the effects of the remaining 

IGMAS+ model for each station. Thereby, each voxel is approximated by a sphere with its volume being identical to the volume

of the voxel. The default of the gravitational constant used for any gravitational calculation is  m  kg  s .

The value of  used in IGMAS+ may be changed by the user following the recommendations of the Committee on Data for

Science and Technology (CODATA).

3.3.1 Handling modelling shift

There is a general gap in magnitude of the measured gravity and the calculated gravity of an IGMAS+ density model. Gravity 

measured in the field is always caused by masses of the entire Earth. The modelled value in IGMAS+ is much smaller in spatial

extent and therefore consists of less mass. To handle this problem, IGMAS+ operates with a shift value, thereby assuming that

all far-field effects not considered by the IGMAS+ density model cause a constant offset in the calculated with respect to the

observed gravity. By default, this shift value is derived from the gravity field values at all stations as follows:

The derived shift value (alternatively, a user-defined one) is then added to the preliminarily calculated ones:

This correction is updated after each modification of the calculated anomaly. By introducing the shift value, the absolute

differences between the observed and calculated anomalies are suppressed in support of the relative differences, which helps

identifying and localising domains of mass deficit or mass excess, in the density model. Figuratively speaking, this means that the

two fields are numerically merged so that their mean values are identical. This is necessary to make the phase (maxima and

minima) and the magnitudes of these anomalies directly comparable in order to get information about the plausibility of the

underground structures.

Gx Gy Gz Gz

Gxx Gxy Gxz Gyx Gyz Gzz

1. 

2. 

3. 

Note on magnetic modelling

H

Hx Hy Hz

Hxx Hyy Hzz Hxy Hxz Hyz

G = 6.67384⋅10−11 3 −1 −2

G

IGMASshift =mean(observed field)–mean(modelled field)

calculated value=modelled value+shift

3.3 Modelling field components and gradients
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3.3.2 Handling edge effects

If the density of the space surrounding an IGMAS+ model was not defined and thus actually set equal to zero, the stations close

to the model borders would reveal gravity edge effects according to the large density differences at the marginal interfaces.

In IGMAS+ there are two solutions to this problem.

The first one is to introduce a reference density (refer to Body Manager) which in fact has two different meanings: first of all, it

is a user-defined density assumed to be present wherever there is no model body, including the entire surroundings of the 3D

model. Hence, an isolated body would automatically be surrounded by the reference density. Secondly, the reference density is

subtracted from all defined densities (i.e., reference and body densities) and any gravity effects at the stations are calculated

from the resulting density differences. Hence, if the reference density is chosen to correspond to an average density at the model

borders, the unwanted edge effects can be substantially reduced. No reference susceptibility is needed. Further minimization of

the edge effects may be obtained through the integration of a layered background reference model which accounts for general

density trends, such as an overall increase with depth.

The case with a layered background reference model has not been yet described in the documentation.

The following sequence of inputs is recommended:

Click on Model in the "Control Window"

Click on "Property Editor"

Select "Border Effect" and then "Border Algorithm"

Select "Voxel Border Effect Kernel" and define a Density-Depth function

This will define a layered background model.

The second strategy for reducing the edge effects of flat IGMAS+ models is to extend the model space for anomaly

calculations beyond the initially defined model. Therefore, the four vertical border planes of the model are automatically

mirrored to a set of new borders and the respective density structure is laterally continued in between. Per default, the amount

of lateral extension is tenfold the total vertical depth range of the initial model. For example, we assume a vertical model

extension of  km. Then the lateral model extension to each side should be larger or equal than  km.

2024-01-31
 

Note

• 

• 

• 

• 

• 

100 1000

3.3.2 Handling edge effects

- 111/122 -© 2024 - Helmholtz Centre Potsdam - GFZ German Research Centre for Geosciences



3.4 Fitting gravity anomalies

IGMAS+ is designed for analyzing the time-independent subsurface density contributions which cause the gravity field; hence,

anomalies to be analyzed should already be corrected for the effects related to instrumental drifts, Earth tides, the “normal

gravity” reflecting the effects of flattening and the centrifugal force as well as the free air and/or mass corrections.

For magnetic field modeling it is important to eliminate the International Geomagnetic Reference Field (IGRF), which describes the

Earth's main magnetic field generated in the Earth's core. In the following, some important remarks are provided that need to be

considered when modelling Bouguer and Free Air gravity anomalies. Magnetic field modelling is performed like modelling of the

Free Air anomalies, since normally no magnetic effects of the topographic masses are subtracted from the field measurements.

3.4.1 Complete Bouguer anomaly (CBA): the "simple" situation

Modelling the complete Bouguer anomaly (CBA). Data are collected

at the green stations (triangles) on the topographic surface or in the

orbit of satellites (stippled line) or on any other height level outside

the model bodies (small green triangles). After definition of Bouguer

anomalies the masses between ellipsoid/geoid are removed. It is

irrelevant whether the ellipsoid or the geoid is the reference surface.

Note on magnetic modelling

3.4 Fitting gravity anomalies
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The gravity effects of the topographical masses have been eliminated from the measured values by the mass correction. This

means, the terrain correction is included, accounting for the deviation of local topographic features by a flat or a spherical slab.

Therefore, the background of the topo-masses is drawn transparent and bright in Figure. Stations of the terrestrial measurements

are indicated by the green triangles; satellite gravity is measured at the orbit level (blue stippled line in Figure).

The density model extends to the geoid/ellipsoid surface. The model stations lie on the topography, at the orbit height or at any

other user defined height. It must be ensured that model stations are identical with the heights and positions of gravity stations in

the field/airplane or satellite orbit.

Note: The density model is bordered by a constant model surface (geoid) as well as by a constant model bottom surface if model is

built by vertical sections (refer to chapter "Model bodies", approach (a)). In case where horizons are used for model

building (chapter "Model bodies". approach (b)), we face a special situation which is described later: a body with the density “0” is

added automatically by the software.

It is irrelevant whether the modelling of satellite gravity is done at the orbit height, or at an arbitrarily chosen level (black with

green triangles in Figure) above the highest elevation. It should be noted, however, that in the case of downward continuation of

the satellite gravity field (from the satellite height to the arbitrarily chosen level), the so-called omission error (geodetic term)

increases the further the chosen level is moved downwards. Reason: the gravity at the orbit height does not contain any small

gravity wavelengths anymore, so that errors/inaccuracies/etc. are increased when the field continues downwards (through the

massless space) and overlay the increased measurement signal.

The reference density of a model can be set arbitrarily by the user if the model structure does not cause a significant boundary

effect.

It becomes difficult if not all mass effects between the surface and the reference surface (geoid/ellipsoid) could be eliminated

because the rock densities deviate from the correction density (usually  km/m ). This information cannot be derived directly

from gravity field modelling but must be extracted from independent information (e.g., geological maps and/or rock density

determinations). In this case these deviating volumes must be later remodelled with a differential density:

3.4.2 Free Air anomaly (FA): the "simple" situation

In contrast to CBA, in the "simple" case of Free Air anomaly no mass correction is performed, so all masses in the model are

preserved - including the topographic masses.

The surface of the density model is now topography-dependent.

1. 

2. 

3. 

4. 

5. 

2670 3

Δρ= ρrock mass−ρmass correction
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Free Air anomaly (FA): the “simple” situation. As in the case of

complete Bouguer anomaly, stations are positioned in the satellite

orbit, on the terrestrial surface marked by green triangles or at any

user defined height level (small green triangles).

The terrestrial stations remain in the positions and at the heights as shown in Figure. If original satellite gravity is used for

modelling purposes, those remain at the orbit height. If a grid with satellite gravity values (e.g. from the ICGEM data bases) is

used, it can be extended down to any user-defined level (black line in Figure). Again, be careful: the omission error must be

considered.

One can "design" the surface of the density model using the heights of the stations and subtracting  cm from each station height:

It is a TIME CONSUMING PROCEDURE to check for all model sections whether the surface of topographic masses is  cm

below the stations. The IGMAS+ developers are currently working on a much simpler method to use 3D topographies in the

modelling. The result will appear in one of the next releases.

The value of  cm comes from the height (above the "ground") of the gravity meter measuring system of LaCoste-Gravimeter. If

gravimeters of other companies are used, the measuring system height must be modified. Otherwise, one can assume an

"overall" model station height of  m above the model surface; the error in larger crust/lithosphere models is to be neglected.

If the user decides to follow the “layer” approach ((b) in chapter "Model setup") and load layers/horizons for building up an initial 3D

density model, IGMAS+ automatically closes the model body upwards with a constant surface (see Top in the Body Manager). This

“Top” body has zero density to mimic the air masses; for more detailed information please refer to this chapter.

Attention:

13

(heights of gravity stations)–13 cm= (height of model top surface)

13

13

1

Hint:

3.4.2 Free Air anomaly (FA): the "simple" situation
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There are two possibilities to define the model station heights (see Figure):

the user chooses a constant height directly representing the satellite orbit (grey and pale blue body together) or

the user continues the satellite data to a height level which is individually chosen by the modeller with reference to the heights

proposed in the table of chapter "Model stations".

The "Top" body can be eliminated manually in the IGMAS+ input file. However, we suggest staying with “0”-density body; it

does not cause any effect on the modelled anomaly and will disappear in one of the next IGMAS+ releases.

... and still, if this body disturbs someone, one can just eliminate it by hand. One can delete its polygons on every section:

go to the first section

right click on "Top"

then select "Remove"

repeat this procedure on every section.

If the "0-Body" doesn't have a single polygon anymore, you can also delete it from the Body Manager, because then "Remove

Body" option is no longer greyed out.

Reference density: in the case of modelling a Free Air anomaly, the reference density must be set to zero (i.e. equal to the

density of the topmost model body representing air)! Hence, one should check if the lateral model extensions are appropriately

chosen to minimize edge effects.

3.4.3 Free Air anomaly (FA): the "difficult" situation

Free Air anomaly (FA): the "difficult" situation. The topographic

surface (e.g., a digital elevation model) is downloaded from an

independent database and does not match the measured station

heights everywhere.

• 

• 

• 

• 

• 

• 

3.4.3 Free Air anomaly (FA): the "difficult" situation
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We start from the same situation as we have already studied for the Bouguer and Free Air anomalies: stations are at the orbit

level or on the terrestrial surface (see Figures for CBA (simple) and FA (simple)). BUT: the terrain surface is now taken from a

digital elevation model (DEM) or an elevation grid available on the web.

The illustration shows that the heights of the measured stations do not always correspond to the heights (often averaged) of the

terrain model. Thus, it can happen that stations are located within the masses formed by the DEM. If this grid is loaded as "layer/

horizon" (compare previous example), then some of the stations are located inside the mass. This leads to errors.

A similar situation must be considered if the satellite field data were continued to a level below the maximum DEM topography

height. To be absolutely sure that this will not happen, choose a level that is "guaranteed" to be above the highest DEM

elevation. For support refer again to chapter "Model stations".

A remarkably similar problem can also occur if the model surface of water masses in an offshore modelling scenario is not

exactly 0 meters and the modeling stations are not  cm above it.

When using grids (a) for satellite gravity (e.g. EIGEN-6C4, GOCE) for comparison with model gravity and (b) for topography (e.g.

MERIT, EMODnet, etc.), always make sure that the model stations are positioned exactly on the nodes of the elevation grid. It must

be ensured that both grids (gravity and heights) have the same grid structure/geometry (same grid width, same projection etc.). The

grid with the satellite gravity can be downloaded for any user-defined level (see Figures for CBA (simple), FA (simple) and FA

(diffucult)) above the topography.

3.4.4 The "Top" body in the density model

Here we will explain the intentions of the "NULL body", which already played a role in previous chapters. This is only valid if

layers/horizons were loaded. For this purpose, let us look at Figure. Originally, the IGMAS+ function was used to read in

individual horizons. Figure shows a stack of horizons that were taken as output from other survey results, e.g., from an offshore

seismic campaign:

13

Hint

3.4.4 The "Top" body in the density model
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A scheme of 7 layers (horizons/interfaces) of an offshore scenario.

The model consists of seven sedimentary layers, where layer ①

indicates the bathymetric layer. For theoretical-methodological

reasons, IGMAS+ closes the model with a “bottom layer” at the

bottom and with a “top layer” at the top (here - the sea surface with

height of 0 m). The user has the possibility to choose the densities

for the automatically introduced bodies “Top” and “Bottom”. The

“Top” body is bounded by the model top layer and the bathymetry

layer (with density of 1000 kg/m³). The “Bottom” body is bounded by

the sediment layer ⑦ and the model bottom layer (with density ρz).

The software sorts the stack of layers first with ⑦ (the lowest layer) to ① (the highest layer). Because IGMAS+ only processes

closed bodies, it “closes” bodies between layers ⑦--⑥, ⑥--⑤, ⑤--④, etc. automatically with the consequence that the user has to

input a layer (in this Figure the top of the “Top layer” is at the sea level) with constant user-defined height ( -top = 0 m) above

the layer ①. Likewise, a constant model bottom layer has to be defined below the layer ⑦ to close the model’s bottom. Both

density-values are user-defined. The "Top" body automatically generated by IGMAS+ gets the density of the water layer: 

kg/m , the "Bottom" body -- an appropriate user-defined density . In the case of a model that contains both onshore and

offshore areas, this body, of course, must be defined accordingly.

Z

1000
3 ρz

3.4.4 The "Top" body in the density model
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Transfer of the offshore situation shown earlier to an onshore

situation when modelling Free Air anomalies. Redefinition of layer ①

into the topographic surface of a model. For more detailed

information refer to the text of this chapter.

The automatic completion of an offshore model with a "Top" layer can also be used to complete an onshore model "upwards" if

we model a Free-Air anomaly. In this case, the "Top" layer has a density of  kg/m . Its upper limit is to be defined by the user

and corresponds to the height at which the small green triangles lie or the blue stippled line is drawn (see Figures for CBA

(simple), FA (simple) and FA (difficult)). These heights are always obligatory to be above the highest elevation of the topography.

In this case of use of "interfaces/horizons" for the input of the model geometry, the "Top" layer in the model is reinterpreted as

“topography layer”. IGMAS+ will then automatically form a body whose upper boundary ("Top" layer in Figure) is defined by the

user; this body is given the density  kg/m  and therefore has no gravity effect on the stations lying on the topography (big

green triangles in Figures for CBA (simple), FA (simple) and FA (difficult)).

3.4.5 Modifications of the density model

The calculated gravity field of a density model can be analyzed based on the respective residual gravity:

When changing the density model, either by changing the density or the geometry of model bodies, IGMAS+ automatically and

instantaneously adjusts the calculated and residual gravity anomaly, which is displayed by a 3D or a 2D viewer (possibly together

with additional constraining data). The 2D viewer always displays one of the working planes, which makes them the actual

scenes of interactive geometrical modifications as implemented through:

moving, deleting or adding of vertices, or

dividing bodies through additional intersections.

Through its interactive mode, IGMAS+ is primarily designed for analyzing and adjusting the 3D density model by visual

inspection of gravity anomalies.

This clearly implies some level of subjectivity in the model evaluation but a major advantage in compression to automatic

0 3

ρ=0 3

1. 

2. 
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algorithms is that it gives the user more control and especially the ability to learn how different features influences the result.

For this reason, in addition to changing the density model through a complicated try-and-error procedure, IGMAS+ also allows

to invert for the density (of one or more bodies) by minimizing the residual of a model.

3.4.6 Remarks on the use of ICGEM gravity datasets

ICGEM stands for “International Centre for Global Earth Models” (Ince et al., 2019). For 15 years ICGEM is one of the five

worldwide services coordinated by the International Gravity Field Service (IGFS) of the International Association of

Geodesy (IAG). Static and temporal global gravity field models of the Earth are provided in a standardized format with a

possibility to assign a DOI number and interactive calculation and visualization services of gravity field functionals are available.

For more information refer also to the instructive ICGEM poster presented at EGU-2019 and to the ICGEM documentation

“Definition of functionals of the geopotential and their calculation from spherical harmonic models” (Barthelmes, 2013; see also 

Ince et al., 2019).

The online availability of global models opens many research possibilities worldwide. However, to use the data provided from

global model grids correctly one should pay an extra attention for what dataset actually represents. In the following section we

provide some hints regarding the use of ICGEM models for geophysical modelling.

The ICGEM documentation (Barthelmes, 2013) in a sophisticated mathematical-physical form shows how the different

functionals and models of the gravity field are calculated. For understanding it is of great advantage to have certain geodetic

knowledge. In the following we will try to give some useful hints in a very simplified manner. The first note refers to all users,

who use the ICGEM anomaly gravity_anomaly_bg .

The ICGEM documentation provides the following comment for the calculation of the "simple Bouguer anomaly":

"The (simple) Bouguer gravity anomaly (Functional selection  gravity_anomaly_bg ) is defined by the classical gravity anomaly

minus the attraction of the Bouguer plate. Here it will be calculated by the spherical approximation of the classical gravity anomaly

minus  (eqs. 107 and 126 of STR09/02). The topographic heights  are calculated from the spherical harmonic model of

topography (ETOPO1) used up to the same maximum degree as the gravity field model:

For  (rock)   kg/m ,

For  (water)   kg/m  is used.

The density contrast between ice and rock has not been taken into account  the results for Greenland and Antarctica are not

correct."

Please have in mind, that  is the height of topography above the geoid!

Fortunately, the differences between geoidal and ellipsoidal heights on Earth are small, however, present everywhere. From the

geophysical/gravimetric viewpoint, not only the disregard of the gravity effects of ice masses is incorrect, but also the calculation

itself. Firstly, a "flat bouguer plate" is considered, not a spherical Bouguer plate. Secondly, no topographic correction is

conducted, which can lead to considerable errors in mountainous areas (Andes, Alps, Apennine, Himalaya). On the other hand,

the transition areas between the continental margins and the oceans are also subject to errors, as Figure shows.

Note

⟹

2πGρH H(λ,ϕ)

• H ≥ 0 → ρ=2670 3

• H < 0 → ρ= (2670−−1025) 3

⟹

H
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Differences of a complete mass correction of gravimetric

measurements (in geophysics) in contrast to the correction

performed at ICGEM, where only a flat plate is attracted.

This illustration shows that in ICGEM's gravity_anomaly_bg  not all masses were correctly removed. Remnants remain in the

topography over land (density  kg/m ) and at the sea (density  kg/m ). The latter residue can be minimized by modelling

the sea water layer by a body with a density of kg/m .

Another remark refers to the meaning of the term anomaly in geodesy and in geophysics (see, e.g., Li & Götze, 2001). The 

illustration below makes the difference graphically clear. A geodetic anomaly always implies, that the gravity anomaly  is

calculated at the geoidal surface which is NOT the "real" topographic surface (see Figure, left). This implies a downward

continuation of  into the topographic masses which is incorrect -- at least from a geophysical point of view.

2670 3 1645 3

1645  3

Δg

gP
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To clarify the concept of anomaly and disturbance. In geodesy, an

anomaly is always calculated on the geoid, which requires a

downward field continuation (left panel) of gp by the amount of H;

this is unstable and therefore forbidden. In contrast, geophysicists

use an upward continuation (right panel) of the normal gravity γ

from the ellipsoid by the amount of h into the position of P to

compute a Free Air anomaly in P. This procedure is mathematically

correct. In geodesy, a Free-Air anomaly is also called disturbance.

In contrast, geophysicists use the term anomaly (here, more precisely, Free Air anomaly) to determine the gravity difference 

 directly at the observation point . For this purpose, it is necessary to perform an upward continuation (height  in Figure)

from the ellipsoid into the measuring point level . This is a mathematically-physically stable procedure and therefore is allowed.

The geophysical Free Air anomaly is the same in meaning as a geodetic disturbance.

So, if the model gravity is to be compared with the Free Air anomaly, in the ICGEM calculation service first the gravity model is

selected under the heading "Model selection" (EIGEN-6C4 is a good choice, also XGM2019), then in the heading "Functional

selection" disturbance  is selected, if no specific non-zero meter altitude is to be selected.

This is dangerous, because then, under certain circumstances, the stations of the Free Air anomaly/disturbance can lie within the

model masses (see chapters on FA (simple), FA (difficult) and on the "Top" body). If the model contains topographic heights which

are higher than 0 m, then select disturbance_sa  in the column "Functional selection" and enter the height in the input mask on

the right under the input of "grid step [°]". The height is freely selectable by the user and must be above the maximum of the

model topography; this corresponds to the height with the small green triangles in Figures for CBA (simple), FA (simple) and FA

(difficult).

To calculate complete Bouguer anomalies it is recommended to download the free-air/disturbance at station level and then

perform Bouguer corrections using a DEM model for both on- and offshore masses.

2023-05-16
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